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Es folgt eine klare Schritt-flr-Schritt-Anleitung mit
bewdhrten KorrekturmaBnahmen in Microsoft Word 2011.

Teile dieses Dokument gern mit anderen, so dass es viele Leute
weiterbringt und ihnen beim letzten Feinschliff hilft.

Das Dokument enthalt externe Links, flir dessen Inhalte Mein Textwerk
keinerlei Haftung Gibernehmen wird.

Fir Feedback, Anmerkungen, Ideen fiir weitere Tipps und bei Fragen
melde Dich einfach unter info@ mein-textwerk.de.
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T Tipp 1

ZUR FORMATIERUNG

In wissenschaftlichen Arbeiten ist ein einheitliches Grundgeriist des Textes ein
Zeichen fiir Genauigkeit und Glaubwiirdigkeit.

Oberste Regel: Halte Dich an die formalen Vorgaben Deiner Institution, wie Du
Deinen Text z. B. hinsichtlich Seitenlayout, Zitierweise, Umbriichen, Silbentrennung
und Verzeichnissen formatieren sollst. Ansonsten lege bitte Deinen eigenen Stil fest
und halte Dich durchweg daran.

1. Lege alle Textstile fest

Nach dem Titelblatt folgt oft das Inhaltsverzeichnis. Allgemein ist es fir die
automatische Erstellung des Inhaltsverzeichnisses immer von Vorteil, wenn Du die
Stile aller verwendeten Kapitellberschriften zu Beginn des Schreibens festlegst und
dann fiir jede kommende Uberschrift anwendest (Abb. 1).

Word File Edit View Insert |Format| Font Tools Table Window § Help

Format = Style

Drop Cap...
Text Direction...
BB Change Case...

— o Wiahle die jeweilige
Style... . Symbol Bro.. Plture

Format Objec

Kategorie aus,
z. B. Uberschrift 1
- Modify

(R

Hier sowie unter

,Format” stellst Du

TextSample TextSample
TextSample TextSample

einmalig alle relevanten
Parameter wie z. B.
SchriftgroBe, Schriftstil,
Abstande usw. fiir diesen

Uberschriftentyp ein.

Abb. 1: Formatierung des Textstils fiir Uberschriften des Typs 1 (Heading 1)
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Das machst Du nun mit allen Stilvorgaben so, die Du in Deinem Text gebrauchst. Also
stellst Du noch den Stil furr z. B. Uberschrift 2 und 3 ein, den ,normalen” Textstil (z. B.
Blocksatz), den Stil fur Bildunterschriften, ggf. Header & Footer usw.

2. Beachte die Silbentrennung (Hyphenation)

Uberpriife bitte, ob Du Vorgaben hinsichtlich der Silbentrennung einhalten musst.
Du hast die Wahl zwischen automatischer und manueller Silbentrennung (Abb. 2).

Word File Edit View Insert Format Font Tools Table Window § Help

New Open Save Save As.. Print ' Cut Copy Paste Format ' Undo Redo ' Show ' Toolbox  Superscript Subscript Equation Edi.. Symbool Brof

Normal Source Sans. 12

A Home | Layout | DocumentElements | Tables | Charts | SmartArt | Review
Page Setup. Margins Text Layout Page Background
B SN . H . Top:2,64[2) Bottom:|2,54[5 © ATE -, i[] Line Numbers ~ .
5 05 =" = . = & L]
Oriemation  Sze  Break  Margins Left: 3 [SIRight (3 [0 pirscrio: lumns be Hyehenatien watermark  Celor  Borders
o ST FERE R SENT EURT SRR NERT FENT Y ST FENY RRY RNy

Hyphenation

Automatically hyphenate document

Hyphenate words in CAPS
Hyphenation zone: |0,63 cm

Limit consecutive hyphens te: No limit

Manual.. Cancel -_

Abb. 2: Lokalisierung des Buttons zur Silbentrennung

3. Nutze Seitenumbriiche (Page break)

Um ein versehentliches Hin- und Herspringen von Textteilen zu vermeiden, nutze
unbedingt Seitenumbriiche (Abb. 3)! Zum Beispiel:

e wenn ein neues Kapitel beginnt.

e wenn eine Grafik nicht mehr auf die Seite passt und Du sie besser auf der
nachsten darstellen willst.

e wenn ein wichtiger Satz beginnt und nicht tiber zwei Seiten verlaufen soll.
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File Edit View

New Open Save Save As.

List Paragrapn

Tn Home | Layout |

"

Pro
U |+

Insert  Format Font

>

AutoText
Field...
New Comment

Footnote...
Caption...
Cross-reference...
Index and Tables...
Watermark...

Table...
Chart...
SmartArt Graphic...

Photo
Audio
Movie
Clip Art
Symbol

Shape...

Text Box
WordArt
Equation
File.

Object...
HTML Object
Bookmark...
Hyperlink...

Tools

Table

Window § Help

Page Break
Column Break e %

joscript Equation Edi... Symbol Bro.]

Section Break (Next Page)
Section Break (Continuous)
Section Break (Odd Page)
Section Break (Even Page)

| AABSCCDOE!

Boak Title

Abb. 3: Einstellung eines Seitenumbruchs
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Deine Arbeit enthalt voraussichtlich mehr oder weniger die folgenden Verzeichnisse:

Tipp 2

e Inhaltsverzeichnis

e Abbildungsverzeichnis
e Tabellenverzeichnis

e Abkurzungsverzeichnis
e Literaturverzeichnis

e Glossar

Verzeichnisse automatisch zu erstellen, erhoht die Chance Fehler in Deinen

ZU VERZEICHNISSEN (INDIZES)

Verzeichnissen zu vermeiden. AuRerdem vereinfacht es Dir die Arbeit mit Indizes.

1. Erstelle Verzeichnisse automatisch

Hast Du Deine Uberschriften wie bei Tipp 1 unter 1. formatiert, hast Du die Mglich-
keit an beliebiger Stelle - zumeist oberhalb Deines Textes — Dein Inhaltsverzeichnis
zu erstellen (Abb. 4). Dieses aktualisierst Du je nach Bedarf beliebig oft wahrend des

Schreibens — entweder nur die Seitenzahlen oder das gesamte Inhaltsverzeichnis.

Word File Edit View | Insert Format Font
[ JCN Break
& . @ E‘ Page Numbers...

New Open Save Save As... (B Wi
I AutoText
Field...
New Comment

Normal = |source san:

| # Home | Layout | O

Footnote...
Caption...
Cross-reference...
Index and Tables...
Watermark...

Table...
Chart...
SmartArt Graphic...

Photo
Audio
Movie
Clip Art
Symbol
Shape...

Text Box
F WordArt

Equation
2 File...
Object...

HTML Object
E Bookmark...

Hyperlink...

Tools Table Window ¢

BRI =

A

| Review |

-

Help

A

Insert 2 Index and Tables =
Table of Contents

Formats;

Index and Tables

incex EFTTFCRCITE Table of Figures  Table of Authorities

From template
Traditional

Contemporary
Modern

simple

e o |

Cancel

e

Heading 3....
Options...

Modify..

Show levels: 3

Show page nus

imbers. Right align page numbers Tab leader: ...

Abb. 4: Vorgehen zur automatischen Erstellung des Inhaltsverzeichnisses
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Hast Du Deine Abbildungsunterschriften, Tabellentiberschriften und ggf. Gleichungs-
nummern jeweils als solche formatiert (liber Style = Figure caption etc.), erstellst Du
Uber denselben Weg Deine Abbildungs-, Tabellen- und Gleichungsverzeichnisse.

2. Verwalte Dein Literaturverzeichnis effektiv

Beim Literaturverzeichnis ist dasselbe Vorgehen wie unter 1. auch méglich. Jedoch
empfehle ich Dir die Kopplung mit einem Literaturverwaltungsprogramm. Ein
kostenfreies, Ubersichtliches und oft ausreichendes Programm ist Mendeley.
Schreibst Du in LaTeX, ist JabRef eine kostenlose, bewahrte Software. Einen
praktischen Uberblick tber die gidngigsten Programme zur Literaturverwaltung mit
ihren Vor- und Nachteilen findest Du hier.

3. Nutze Querverweise (Cross-reference)

Dein seitenlanges Manuskript bekommt fiir das digitale Lesen mit Hilfe von
Querverweisen erheblich mehr Ubersicht (Abb. 5+6). Das Lesepublikum kann
bequem zu den relevanten Stellen im Text springen, um sich dort weiter zu
vertiefen.

Word File Edit View  Insert Format Font Tools Table Window § Help
eoe Break

E p @ E i Page Numbers...

v 2 A, =% €% =
New Open Save Save As... P DA U, do Redo S:lw Tugox Suj :r\scn t Subs:ri t ua::::id\ s mf::\MBrn P\cﬁ
Gk AutoText do Ree  Sh P et Di L Pt Ea e SYT
Normal 1] |source safRN = = = % == GEe= B - A
T New Comment | Charts | SmartArt | Review |
Font rach Styles
Footnote... — Insert 9
s - M " = [ 1 A
Source Sans Pro_|»[[12 |~ ePr N 2= |0 nasbcendee aasbceodee. AgBlp( AaBbCeDdl aabecodee )
AFAEISEIPEARY  Cross-reference... =By | e 1) | N0 spaciog | |_oming 1 | | woating2 | |_noncings |
= Index and Tables... Cros S -
" Watermark... SRR WARPN AR RTINS ANAPY NN BWINS NN MR WO | WATRE AR WRrR T WO
: bentrennung reference >
1 ‘SmartArt Graphic... » . P . - .
[ s riife bitte, ob Du Vorgaben hinsichtlich der Silbentrennung einhalten musst.
1 Photo st die Wahl zwischen automatischer und manueller Silbentrennung (Abb. 2). REference

Audio
Movie

Symbol
b Shape...

Movle ,u === . type ...

‘WordArt

Equation

= File...
Object...
HTML Object
Bookmark...
Hyperlink...

|
|
|
|
|
|
1B Text Box
|
|
|
|
|
|

Abb. 2: Lokalisierung des Buttons zur Silbentrennung in Word

Abb. 5: Einfligen von Querverweisen
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B-E&H B = o MR : w2 & = a-
New Open Save Save As.. Print - Cut Copy Paste Format - Undo Redo : Show - Toolbox Subscript Equation Edi.. Symbol Bro... Piture... Quick Search
[Normal [¥] [Source Sans..J¥| 12 [¥|: B I U = EE4E B - A
| # Home | Layout | Document Elements Tables | Charts | SmartArt | Review |
Fant Parzgragh Siyles Insert Themes

Source Sans Pro_|+[[12|~|[As[A~] [ £z (%2)
B|I | U |-#e A|A] A -~ |4~

Normal N Spacing

AaBbCeDdEe  AaBbCcDdEe AaBb( AaBbCcDd| AaBbCeDdEe “'

Heading 1

®

i)

Picture - Themes

Heading 2 Heading 3

Textdox  Shape

2. Silbentrennung

Uberpriife bitte, ob Du Vorgaben hinsichtlich der Silbentrennung einhalten musst.
Du hast die Wahl zwischen automatischer und manueller Silbentrennung (Abb. 2).

H 3
e 0w s 1 0. Pt Gl . Po Foman U e S i Supineron Sbirtt e .. Sy

Abb. 2: Lokalisierung des Buttons zur Silbentrennung in Word

3. Umbriiche

o0 0 Cross-reference

Reference type:

Entire caption

Abb. < v Only label and number
Only caption text
Page number
Above/below

Insert as nyperlink

For which caption:

Abb. 1: Formatierung des Textstils fi...schriften vom Typ 1 (Heading 1) in .
okalisierung des Buttons zur Silbentrennung in Word

instellung fr Seftenumbruch in Word

Abb. 4: Vorgehen zur ng des

in Word

Insert

Cancel

Abb. 6: Art des Querverweises festlegen
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Tipp 3

ZUR ZEICHENSETZUNG (INTERPUNKTION)

1. Entferne berfliissige Leerzeichen

Wahrend Du hintereinander weg schreibst, passiert es schnell, dass sich gleich zwei
Leerzeichen nacheinander einschleichen. Diese Stellen sind normalerweise mit dem
Auge schwer zu erkennen. Mit der Suchfunktion in Word findest Du doppelte
Leerzeichen sofort.

e Driicke gleichzeitig die Steuerungstaste und den Buchstaben ,F” (fur ,find”).
e Tippe dann zwei Leerzeichen nacheinander in das Suchfeld ein und driicke
~Enter”.

Ctrl| + >

Solltest Du kein Ergebnis bekommen, gibt es keine versehentlich doppelten

Suchfeld

Leerzeichen. Zeigt die Suche Ergebnisse, klicke Dich durch und entferne die
Uberflissigen Leerzeichen fir jedes Suchergebnis.

2. Verwende geschiitzte (schmale) Leerzeichen

In den meisten akademischen Arbeiten gibt es Zahlen in Verbindung mit ihren
MaBeinheiten wie etwa 10 kg oder 35 %. Um die beiden Elemente fest miteinander
zu verbinden und eine unschone Trennung durch die Einstellung zum Blocksatz
oder am Zeilenende zu vermeiden, gibt es das geschiitzte Leerzeichen.

Das gilt auch fiir Referenznamen zu Grafiken, Tabellen, Gleichungen und ggf.
Literaturnachweisen wie z. B. Abb. 12 oder Tab. 2.

Abhdngig vom Betriebssystem haltst Du dafiir drei Tasten gleichzeitig gedriickt.

Windows: Ctrl]| + | Shift| + | Space
=geschitztes Leerzeichen
Mac: Ctrl] + | Alt | + | Space

www.mein-textwerk.de () Mein Texdwerk Seite 10/26


https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de/
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de
https://www.mein-textwerk.de

Beispiel:

Du willst, dass die MaBangabe 25 mm immer zusammensteht, ohne
versehentlich auseinandergezogen zu werden (Windows).

Tippe: 25

Ctrl| + | Shift| + | Space

... und Du bist auf der sicheren Seite!

3. Uberpriife klassische Abkiirzungen

mm

Es gibt eine Reihe von Abkiirzungen, die viele von uns typischerweise nutzen. Setzen

sie sich aus zwei oder mehreren einzelnen Buchstaben zusammen, gehort immer ein

Festabstand dazwischen. Flige hier bitte ein geschiitztes Leerzeichen ein!

Abkiirzungen: z. B.
u. a.
d. h.
e. V.
S.4..

Nutze gern die Suchfunktion (Ctrl+F), um alle Abkirzungen aufzuspiiren und fiir jede

gefundene Abkilirzung manuell ein geschiitztes Leerzeichen (siehe 2.) einzufligen. Ich

ermutige Dich dazu, Dir diese Methode fir
anzugewohnen.

Beispiel: d. h. (Windows)

Tippe: d. Ctrl| + | Shift| + | Space

www.mein-textwerk.de
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4. Sei achtsam mit der Art der Verbindungsstriche

Es gibt grammatikalische Unterschiede in der Lange von Verbindungsstrichen. Eine

Zusammenfassung mit klassischen Beispielen findest Du in Tabelle 1.

Tab. 1: Vergleich zwischen Binde- und Gedankenstrich mit markanten Beispielen

Bindestrich -

Gedankenstrich -

Lange
auch bekannt
als

Tastenkdurzel

Anwendung

kurz
Viertelgeviertstrich
Bindestrich
Erganzungsstrich
Minuszeichen

zusammengesetzte Worter,
z. B. DNA-Analyse, 25-jdhrig

Silbentrennung am Zeilenende,

z. B. , Der optische Strahlengang
verlduft divergent.”

Erganzung von Wortbestandteilen,
z. B. hin- und hergerissen
URLs/Webadressen,

z. B. www.mein-textwerk.de

lang

Halbgeviertstrich

Bis-Strich

Streckenstrich

Windows: Strg+Minuszeichen
Mac:
Satzeinschiibe zur Hervorhebung,

Alt + Minuszeichen

z. B. ,Erist — je nach Wetterlage -
nord- oder siidwadrts gerichtet.”
Satzanhdnge,
z. B. ,Die Aufiistung erfolgte sofort -
ganzim Sinne der Kundschaft.”
Minuszeichen in Berechnungen,
zB21-713=8
Ersatzzeichen fir das Wort , bis”,
z. B. 300-500mg, S. 12-15
runde Geldbetrage,
z.B.20-EUR
Streckenbezeichnungen,
z. B. Berlin-Hamburg
Spiegelstrich in Listen,
z. B. - Einleitung

- Hauptteil

- Zusammenfassung

www.mein-textwerk.de
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5. Wende Anglizismen mit Bedacht an

Es gibt haufig Verwirrung bei Anglizismen, die sich mit einem deutschen Grundwort
vermischen - verbinde bitte alle Wérter mit einem Bindestrich!

Beispiel:

Englische Worter: High Throughput Screening
Deutsches Grundwort: Anlage

Korrekte Verbindung: High-Throughput-Screening-Anlage

6. Vergewissere Dich der Art der Anfiihrungszeichen

In der deutschen Sprache nutzen wir korrekterweise die ,Gansefiiichen”, die unten
einer ,99” und oben einer ,66" dahneln. Falsch sind daher "Kodierungs'"- und
"Zollzeichen". Eine weitere Hervorhebung innerhalb der GansefiiBchen erfolgt mit
,einfachen GansefliiBchen’. Im Englischen sind beide Anflihrungszeichen "oben”.

7. Klarheit bei Kommaregeln & Setzen von Semikola

Die neue deutsche Rechtschreibung (3. Fassung der Reform im Jahr 2006) lasst uns in
einigen Fallen einen Spielraum, ob wir ein Komma (Beistrich) setzen wollen oder
nicht. Die gebrauchlichsten Kommaregeln darfst Du hier oder auch hier nachlesen.

EIN ALLGEMEINER TIPP ZUR KOMMASETZUNG

Solltest Du Uber ein Komma griibeln, empfehle ich Dir folgende Handlung: Sprich
den Satz, den Du schreiben mochtest, laut aus. Bei jeder natiirlichen Atempause
oder Atemveranderung setzt Du fast immer ein Komma.

WANN UND WOZU BENUTZE ICH EIN SEMIKOLON (STRICHPUNKT)?

Du uberzeugst Deine Leserschaft durch abwechslungsreiches Schreiben. Deinen
Stil hebst Du auf ein hoheres Niveau, indem Du gelegentlich Semikolons bzw.
Semikola setzt. Du nutzt das Semikolon einerseits zwischen Hauptsdtzen, die
inhaltlich eng miteinander verkniipft sind. In solchen Féllen ware auch ein Punkt
zwischen zwei Satzen korrekt. AulBerdem strukturierst Du Aufzahlungen mit einem
Semikolon. Willst Du mehr dariiber erfahren, lies bitte hier weiter.
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8. Doof mit dem Apostroph (Hochkomma)?

Der korrekte Apostroph gleicht typografisch einer ,9”.

Im Genitiv gibt es kaum Apostrophe; es heiflt ,Mozarts Werk”. Allerdings folgt
Eigennamen mit den Endungen -ce, -s, -ss, -B, -tz, -x oder -z im 2. Fall ein Apostroph,
z. B. ,Brahms’ Kammermusik”.

Verschmelzen Prapositionen mit Artikeln, folgt in der Regel kein Apostroph, z. B.
»durch +das = durchs”, ,hinter + dem = hinterm”.

9. Falls Du Auslassungspunkte nutzt ...

Setze bitte vor und nach Auslassungspunkten ein (ggf. geschiitztes) Leerzeichen. Der
Satzschlusspunkt entfdllt; nur Frage- und Ausrufezeichen darfst Du nach den
Auslassungspunkten setzen.

10. Noch mehr Bock auf Rechtschreibung?

Willst Du weitere Feinheiten der deutschen Rechtschreibung erkunden, schau gern
online beim Duden oder auch hier vorbei.
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Tipp 4

ZU ABBILDUNGEN & TABELLEN

Prasentierst Du wichtige Inhalte in Form von Grafiken oder in Tabellenform, lockert
es eine umfangreiche Textarbeit wie etwa eine Abschlussarbeit enorm auf.
Abbildungen und Tabellen bilden eine abwechslungsreiche Erganzung zum Text.
In den folgenden Abschnitten findest Du wirksame und ausfiihrliche Anregungen, wie
Du diese visuellen Elemente addquat aufbereitest.

1. Abbildungen

Der Einsatz von Grafiken hat vielfaltigste Vorteile:

e Bilder sagen mehr als 1000 Worte.

e Komplexe Zusammenhange sind in einem Bild verpackt leichter zu verstehen.

e Grafiken erzeugen Spannung. Ergebnis: Die Freude und Aufmerksamkeit der
Leserschaft steigen enorm.

¢ Bilder haben einen hohen Wiedererkennungswert. Sie dienen teilweise als
Aushangeschild einer Textarbeit (z. B. in Fachpublikationen).

Es gibt einige Stolperfallen beim Integrieren von Abbildungen in einen umfang-
reichen Text. In der folgenden Liste erhdltst Du praxiserprobte Hinweise zum
Umgang mit Grafiken in akademischen Schreibprojekten.

1) Bildreferenz: Kiindige eine Abbildung, wann immer méglich, VOR der
Prasentation im Text an.

Beispiel: Die folgende Abbildung (Abb. 7) stellt den
zeitlichen Verlauf des Experiments dar.

WIRKUNG

8
(4
L ZEIT

Abb. 7: Die Wirkung des
Experiments im

zeitlichen Verlauf
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2)

Einfligen: Nutze zum Einfligen des Bildes in den Text entweder Copy/Paste
oder ,Insert > Photo - Picture from File”. Damit Du die Abbildung sorglos an
jede beliebige Stelle im Text positionieren kannst, empfehle ich Dir dringend
die folgende Ausrichtung am Text: Uber einen rechten Mausklick auf die
Grafik wahlst Du die Option ,Wrap Text” und dahinter ,None” aus (Abb. 8).

- EH @ 200 =T T 8 & =

New Open Save Save As... Print : Cut Copy Paste Format  Undo Redo . Show . Toalbox = Superscript Subscript Eq

§
5
g
Gl
g
£
3
g
g
]
]
3

Normal =| source sans.. |+ 50 = < m]
R

| # Home ; Format | Layout | DocumentElements | Tables | Charts | SmartArt |

s

e e e T e e P
o ! =] ‘VV) ! ' ! '
[ Y cut 38X
Copy ®C
I

7 @ Paste B8V
. Arrange >
Grouping »
Align or Distribute >
fi »> In Line with Text
Insert Caption...
Square
Format Text Effects... Tight
Format Object.. Through
Top and Bottom
Hyperlink... LS/ None

Abb. 8: Ausrichtung der Grafik ohne lastiges Verschieben des Textes

Bildunterschrift: Die Beschreibung von Abbildungen erfolgt immer uNTERHALB

des Bildes! Flige die Bildunterschrift im gesamten Textverlauf immer auf die
gleiche Weise ein, z. B. mittig unter die Abbildung oder linksbuindig.

Positionierung: Flige Bilder im gesamten Textverlauf immer auf die gleiche
Weise ein, z. B. immer mittig oder immer linksbiindig.

Vereinheitlichung: Versuche alle eingefiigten Grafiken, wenn maoglich,
einheitlich zu gestalten, z. B. gleiche farbliche Umrahmung aller Bilder.

Bildinhalt: Verwende Schriftgro3en in der Grafik, die ungleich kleiner als die
Schriftgrof3e des FlieBtextes im Dokument sind. Nutze einen stimmigen
Kontrast.
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7) Zuschneiden: Nutze die Zuschneidefunktion (Crop) von Word, um unwichtige
Teile der Grafik zu entfernen (Abb. 9).
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Bl —_— = = T T Iﬁsmr- —
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[ ) E] 4 ER R 8 ) b i
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# Home . FormatPicture | Layout | DocumentElements | Tables | Charts | SmartArt | Review |
pictur Siyles
Ea- (=t ] ﬁawduv -

|| g Effects+  Transparency

Abb. 9: Anwendung der Zuschneidefunktion

8) BilddateigroBe: Verwende bei den eingefiigten Grafiken eine geringe, visuell
ausreichende Auflosung, damit die Gré3e Deiner Textdatei so gering wie
moglich bleibt.

9) Urheberrecht: Kennzeichne eine externe Urheberschaft bitte immer klar in
der Bildunterschrift.
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2. Tabellen

1) Tabellenreferenz: Kiindige Tabellen, wann immer mdoglich, VOR der
Prasentation im Text an.

2) Einfugen: Nutzt Du Word-Tabellen, bekommst Du die besten Ergebnisse,
wenn Du den , Text Umbruch” auf ,Mit Text in Zeile” formatierst. Zum
Einfligen externer Tabellen in den Text nutze vorzugsweise , Insert > Photo
—> Picture from File”. Willst Du z. B. Tabellen aus Excel in Word Ubertragen, ist
ein reibungsloserer Weg das Einfligen als Grafik statt das Hineinkopieren der
Excel-Tabelle per Copy/Paste-Funktion.

3) Tabelleniiberschrift: Grundsatzlich befindet sich die Beschreibung einer

Tabelle immer OBERHALB qar Tabelle.

4) Tabelleninhalt: Verwendete SchriftgroBen innerhalb der Tabelle sind
idealerweise ungleich kleiner als die des normalen FlieBtextes. Haufen sich zu
viele Daten bzw. Gbersteigen diese die Anzeige auf einer Seite, hilft die
Anschauung in Form eines Anhangs am Ende der Textarbeit.
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Tipp 5

ZU TYPISCHEN STOLPERSTEINEN

Kommen wir zur Rechtschreibung und Grammatik. Jeder Mensch hat seine Starken
und Schwachen. Und jeder hat eine Ahnung von seinen , Lieblingsfehlern”.

Dafiir lohnt sich das Erstellen einer persénlichen Fehler-/Korrekturliste. Diese
Liste wird Dir auch in zukiinftigen Schreibprojekten wieder von Nutzen sein.

Sobald Du Deinen Text Korrektur liest und Dir etwas auffallt, notiere Dir den
gefundenen Fehler, z.B. einen Tippfehler. Merkst Du oder weif3t Du, dass sich
bestimmte Fehler bei Dir haufen, wirst Du Deinen Fokus besser darauf setzen.

In Tabelle 2 findest Du eine Auflistung typischer Fehler. Sie entstehen meist aus
Unachtsamkeit (Tippfehler), Unwissenheit oder Unsicherheit. Die Tabelle liefert
entsprechende Losungsimpulse.
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Tab. 2: Typische Fehler und jeweilige Lésungsimpulse

Typische Fehler

Lésungsimpulse

Satz- oder Wortwiederholungen

Buchstabendreher,
z B. ,Beduetung/Bedeutung”

fehlende Buchstaben
fehlerhafte Kommasetzung
Verwechslung von Komma und Semikolon

Verwechslung von Binde- und
Gedankenstrichen

doppelte Leerzeichen

Verwechslung von Woértern,
z B. ,das/dass”, ,seid/seit”, ,als/wie”

unvollstéandige Vorsilben,
z. B. ,vewechseln/verwechseln”

Verwechslung von Fallen,
z. B. Dativ & Genitiv oder Dativ & Akkusativ

uneinheitliche Schreibweise,
z. B. ,Fotografie/Fotographie”

Haufung mannlicher Wortbilder,
z. B. ,der Kunde”, ,der Leser”

Vermischung verschiedener Zeitformen

Umgangssprache

unnétige Flllworter

unnétiges , s” in Plural-Akronymen,
z B. ,LKWs/LKW", ,AGBs/AGB*, ,,PCs/PC”

doppelte Formulierungen,
z. B. ,IBAN-Nummer/IBAN”

nutze Synonymvorschlage und ersetze,
z. B. mit Hilfe einer Synonymdatenbank

lies Deinen Text riickwarts

lies Deinen Text riickwarts
siehe Tipp 3 unter 7.
schau hier nach

siehe Tipp 3 unter 4.; das hier hilft dabei

splre sie durch die Word-interne Such-
funktion (Ctrl+F) auf (siehe Tipp 3 unter 1.)

typische Beispiele und Erlduterungen gibt
es hier

lies Deinen Text riickwarts

eine iberschaubare Erklarung zu den vier
Fallen gibt es hier

entscheide Dich durchgangig fiir eine
Version

genderneutrale Sprache verwenden,
z. B. mit Hilfe dieser Website

bleibe, wenn maoglich, im Prasens

lies viele Fachtexte und erhohe so Deine
Sprachqualitat

eine Liste solcher Flllworter findest Du hier

sprich das Kurzwort voll aus und priife, ob
ein ,s” in der Mehrzahl folgt oder nicht

priife, ob das Folgewort bereits in der
Kurzform vorhanden ist oder nicht
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—) Tipp6

AN ZUM INHALT

Dies wird kein Abschnitt Uber das Lektorieren werden. Sondern wahrend des
Korrekturlesens gilt es die Zahlen, Daten und Fakten (ZDF), die Du inhaltlich
angibst, nochmals auf Richtigkeit zu priifen. Dazu zahlen insbesondere ZDF

e in Textabschnitten,

e in Abbildungen,

e inTabellen,

e aus Referenzen,

e inder Beschreibung von Prozessablaufen oder Methoden.

Daneben ist es auch wichtig alle Eigennamen mit einem anfanglichen GroB3-
buchstaben zu versehen und das zu Uberprifen. Verwendest Du Eigenworter
mehrfach im Text, nutze die Suchfunktion (Ctrl+F), um alle zur Priifung ausfindig zu
machen. Damit bist Du schneller.
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Tipp 7

ZUM KORREKTURLESEN ALLGEMEIN

Fir die Schlusskorrektur bieten sich mindestens zwei bis drei Durchgange des
gesamten Manuskripts an - idealerweise mit einem Abstand von ein bis zwei
Tagen dazwischen.

Je nach Belieben gehst Du kapitelweise vor oder liest Deine Arbeit am Stiick mit
Fokus auf bestimmte Dinge (z. B. Zeichensetzung oder Formatierung).

Du schaust nun seit Tagen oder gar Wochen auf Dein Werk. Je 6fter Du Deinen Text
liest, desto mehr pragt sich Dein fotografisches Gedachtnis unbewusst die Ansicht
ganzer Textpassagen ein. Du wirst quasi blind fiir Deinen Text und kannst
Flichtigkeitsfehler kaum noch erkennen.

Um aus diesen gewohnten Mustern auszubrechen und Deinen Text wieder neu
Korrektur zu lesen, braucht es drastische Veranderungen.

1. Verfremde Deinen Text

Damit wird sich Deine Aufmerksamkeit flr den Text wieder erhéhen. Dazu gibt es
neben vielen anderen die folgenden Hilfsmittel:

Verandere Deine Leseumgebung:

Verdndere das Schriftbild e Drucke Deinen Text auf Papier
Deines Textes am PC: aus. Lies ihn, wo immer Du
Konzentration und Muf3e daftir

e Wibhle eine andere SchriftgroRe. hast.

e Wahle eine andere Schriftart. e Lies auf Papier jeweils nur eine

e Wahle eine andere Schriftfarbe. Zeile, indem Du den Rest

e Wahle einen anderen Kontrast abdeckst.
zwischen Hintergrund und e Bring, falls Du auf einem tragba-
Schriftbild. ren Medium liest, Dein Gerdt zum

Lesen an einen ungewohnten Ort.
Das kann statt dem Schreib- der

Gewinne Abstand zu Deinem Text: A e edh eetar dlar Ballan

Lass das Manuskript fiir 1-2 Tage komplett liegen sein. Oder gehe ganz nach
und widme Dich ausschlieBlich anderen Dingen — drauBen in den Park. Oder lies
am besten solchen, die Dir gut tun. den Text in der Bibliothek oder in

NN,
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2. Nutze Tools zur Rechtschreibepriifung

1. Nutze die automatische Rechtschreibepriifung in Word. Uberpriife vorher die

Einstellung der korrekten Sprache des Textes.
2. Nutze die folgenden kostenlosen Angebote:
e Rechtschreibpriifung von Duden online,
e LanguageTool Plus,
e Rechtschreibpriifung24 oder

e Spellboy.

3. Verwende die Anzeige der Formatierungszeichen in Word (Abb. 10), um Fehler

aufzuspiren.

#-@ H

New Open Save Save As.. Print | Cut Copy Paste Format | Undo Re:

»

Normal = |Source Sans.

i

g

3.-Gewinne Abstand zu Deinem Text: T
* - Lass das Manuskript fiir 1-2 Tage komplett liegen und widme Dich
ausschlieRlich anderen Dingen —am besten solchen, die Dirgut tun. T

Abb. 10: Einschalten der Formatierungszeichen

3. Zeit fir Deine Selbstfiirsorge

Bei all dem Stress kurz vor der offiziellen Abgabe Deiner Abschlussarbeit libersiehst
Du schnell etwas Wesentliches: Deine Aufmerksamkeit fir Deine Grund-
bedirfnisse. Versuche aktiv Inseln der Ruhe und des Wohlbefindens einzubauen.

1.

Mache bewusst Pausen: Lies hochstens eine Stunde Korrektur und génne Dir
dann eine mindestens 10-minttige Pause, bevor Du weitermachst.

2. Hoére auf Dein Hungergefiihl: Iss etwas Gesundes wie Nusse, Obst oder
Gemduse.

3. Trinke ausreichend Wasser oder ungesiilte Getranke. Vermeide ein
aufkommendes Durstgefuhl.

4. Bewege Dich mindestens 30 Minuten pro Tag an der frischen Luft, entweder
durch einen Spaziergang oder ein sportliches Training.

5. Schlafe ausreichend, damit Dein Korper ausruhen darf und Dein Hirn
denkfahig bleibt.

6. Lass den Perfektionismus hinter Dir. Du tust alles, was Dir moglich ist; nicht

www.mein-textwerk.de
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Schlusswort

Hast Du vor Deine Arbeit an Freunde, Verwandte oder Dein berufliches Team zum
Korrekturlesen weiterzugeben, ermutige ich Dich dazu, vorher den gesamten
Leitfaden abzuarbeiten. Deine zukinftigen korrigierfreudigen Leute werden es Dir
danken :-)

Gibst Du Dein Manuskript nach dem Durchgang dieses Praxis-Guides in
professionelle Hande, wirst Du generell bei den Angeboten Geld einsparen, bei
denen die Kosten nach einem Stundensatz ermittelt werden.

Willst Du den finalen Feinschliff Uber Mein Textwerk nutzen, hast Du bis hierhin

schon wertvolle Vorarbeit geleistet; deshalb bekommst Du die Schlusskorrektur bei
mir zu einem verglnstigten Preis!

Eine gelungene Abschlussarbeit bringt Dich auf den nachsten Level - viel Erfolg auf
Deinem Weg!

Deine Annett Fischer von Mein Textwerk
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